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Lab 1 
Creating a Nios II System 
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Hardware set up requirements: 
 
• ByteBlaster, ByteBlaster II, Byte Blaster MV, or USB-Blaster connected between 

computer and ByteBlaster connection on development board 
• Power supply connected to the board 
 
 

1. If it doesn’t exist already, create a directory on the C drive of your computer called 
“altera_trn”.  Copy the self-extracting zip file nios_II_lab.exe to that directory and double 
click on it, and select unzip.  This will unzip the lab files.  Among these files is the partially 
completed Quartus II project and a software folder that we will use today. 

 
 

2. Start the Quartus II Software by double-clicking on the project file, 
C:\altera_trn\Nios2\DE2Project.qpf.. 
 

3. Device family and pin assignments are OK in this Quartus II project. You can view them 
in Assignments Menu. 

 
4. Let’s now build our embedded system!  Start SOPC Builder from Tools => SOPC 

Builder… and provide the system name, niosII, when the next window pops up.  You can 
choose VHDL or Verilog (whichever you prefer) as the implementation language.  The 
blank SOPC builder window will open.  Set Target to the particular dev kit you are using (eg. 
Nios Development Board, Stratix EP1S10), and set the Clock frequency to 50 MHz. 
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5. From the left hand window pane select Nios II Processor and click Add.  Select Nios II/s 
for the processor core, and accept Embedded multiplies as the Hardware Multiply option.  
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6. Now, click on the JTAG Debug Module tab.  Select the JTAG Target Connection 

Download Level 1 option.  This will provide us with all the debug options listed on that tab. 

 
 
 

7. Click Finish.  This will add it to the SOPC Builder system. 
 

8. Rename the processor by right clicking on it and selecting Rename. Type in cpu and hit 
enter. 
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Note: It is essential for you to enter the names of all  peripherals and memories EXACTLY 
as shown in the lab guide since these components will be  referenced later on in the C–code.  
Also, be sure that you type each name  with the correct CASE. 
 

 
9. From the left had window pane select Avalon Tri-State Bridge from the Bridges section 

and click Add.  Select the Registered option and click Finish.  Rename the peripheral 
ext_ram_bus. 

 
 

10. From the left hand window pane select Flash Memory (Common Flash Interface) from the 
Memory section and click Add.  Choose one of the following: 
DE2 boards: custom preset with an address width of 20 and a data width of 8 

 Click Finish.  Rename the memory to ext_flash. 
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11. From the left hand window pane select EPCS Serial Flash Controller from the Memory 
section and click Add. Accept the defaults. 

 
12. From the left hand window pane select Interval Timer from the Other section and click 

Add. Accept the defaults and click Finish. Rename the timer to sys_clk_timer. 
 

 
 

13. From the left hand window pane select JTAG UART from the Communication section and 
click Add. Accept the defaults. (The screen should appear as shown. ) 
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14. Click on the Simulation tab and select Create ModelSim alias to open a window showing 
output as ASCII text.  Click Finish, and ename the peripheral jtag_uart. 

 

 
 

 
 

15. From the left hand window pane select PIO (Parallel I/O) again and click Add. Enter a 
width of 4 bits, with Input ports only. 
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16. Click on the Input Options tab and select Edge Capture Register and Generate IRQ, click 

Finish. Rename this peripheral button_pio. 
 

 
17. From the left hand window pane select PIO (Parallel I/O) again and click Add. Enter a 

width of 8 bits, with output ports only. Click Finish. Rename this peripheral led_green. 
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18. From the left hand window pane once again select Interval Timer from the Other section 
and click Add. Change the period to usec, and click Finish. Rename the timer to 
high_res_timer. (We are going to use this later when we time the speed of some of our 
software functions.) 

 

 
 

19. From the left hand window pane in the Display section, select Character 
LCD(16*2,Optrex 16207) and click Add. Accept the defaults. 

 
20. From the left hand window pane select System ID Peripheral from the Other section and 

click Add.  Accept the defaults. 

 

21. From the left hand window pane select UART (RS-232 serial port) from the 
Communication section, accept the defaults and click Finish.  Rename this peripheral uart1. 

 

22. From the left hand window pane in the memory section, select SDRAM Controller, custom 
preset with Data Width of 16 Bits, click Finish. Rename this peripheral sdram. 
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23. Now, add the Altera PLL component to the project from the Other components folder.  Then 

launch the ALTPLL MegaWizard and configure the PLL using the settings shown below.  
(Navigate through the Wizard using the Next button). 

 
 
 

 
 
 
 

PLL Parameters: 
 

           

Input Clock Freq   50 MHz 
Auto PLL Selection  ON 
Mode Normal 
 
Jump to page for C0: 
C0: Mult Factor =  1 
 Div factor   =   1 
 Phas shift   =   0  
 Duty Cycle =  50%  
 
Jump to page for C1: 
C1: Mult Factor =  1 
 Div factor   =  1 
 Phas shift   =   -3.00 ns 
 Duty Cycle =  50% 
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The final page of the PLL Wizard should resemble the following: (Note:  there will be some 
minor differences depending on what language you have chosen for your project.) 

 
 
Select Finish and then Finish one more time to add the component to the SOPC Builder 
system; then re-name it, pll. 
 
Double click in the clock window, and re-name clk_1 to sys_clk, re-name clk_2 to 
sdram_clk.  The system Clock window should appear as follows: 
 

 
 

 
Now click in the Input Clock column for all peripherals except the pll, and change the input 
clock to sys_clk. 

 ie. 

 
 
 

 
24. To ensure that all base addresses are valid, right click on any one of the base addresses in the 

table and select Auto-Assign Base Addresses. 
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25. Now, we must ensure that the appropriate master/slave connections are made. Go to the 
View menu and turn on Show Connections if it is not already done so.  (A check mark will 
appear beside your selection.) 

 
 
 
 

 
Your system should look like the image on the following page: (with the Target set to the 
particular board you are using) 
 

 
 
 

26. Now, click on the Nios II More “cpu” Settings tab. This page is used to establish the reset 
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and exception addresses of the CPU.  Select epcs_controller for the Reset Address and 
sdram for the Exception Address. Click Next. 

  
 
 

27. check the Simulation checkbox – both boxes should be checked by default.  
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28. Click Generate. SOPC Builder will now produce the parameterized Nios II processor system. 
 
 
29. After SOPC Builder has finished generating your system open the partially-completed 

DE2Project.bdf schematic in Quartus II using File->Open so that we can add the SOPC 
Builder system to our Quartus II project:  Double-click anywhere on the schematic to open 
the Symbol viewer. Then, open the Project folder in the Symbol Viewer and select the 
niosII symbol.   

 
 
 

30. Press OK and locate and place the symbol in the schematic so that it lines up with the pin 
placements as shown below.  The pins should all line up exactly!  If they don’t, chances 
are that you need to go back to thee SOPC Builder and re-check your work. 
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31. Now save the schematic and start compilation in Quartus by selecting Start Compilation 
from the Processing menu. 
 
 
Do not wait for compilation to complete.  We will continue from this point during the next 
lab. 

 
 
 
 

END OF LAB 1
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Lab 2 
Software Flow 
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1. We will now download the Nios II FPGA design created in the previous lab to the Nios 
development board.  Within Quartus II, select the Programmer from the Tools menu.  (If 
the .sof file for your project does not populate the File field then click on the Add File button 

.  Then select file DE2Project.sof and click Open. 
 

2. Tick the Program/Configure checkbox for that .sof file, and then click the Start 
Programming icon . 
 

3. Launch the Nios II IDE from the SOPC Builder.  (Tools > Nios II IDE)  Select OK when 
the Workspace Launcher dialog box appears. 
 

4. Go to the Nios II IDE Workbench, create a new software project by selecting New->Project 
from the File menu.  In the Altera Nios II sub folder, select C/C++ Application, and press 
Next. 

 
 

5. In the window that appears, type niosII_training_project as the name of the application to 
be created. Then verify that the ptf file from your SOPC Builder session (niosII.ptf) has 
automatically populated the SOPC Builder System field in Select Target Hardware pane.  
Now select the Blank Project template from the Select Project Template panel on the left 
hand side of the window.  The New Project window should now resemble the following 
window: 
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Note:  As an alternative, for Step 2 we could have also launched the Nios II IDE from the 
Windows Start menu >All Programs > Altera > Nios II Development Kit 1.0. 
 

 
 

6. Press Next.  Indicate that you are creating a new system library for your application by 
selecting the Creating a new system library named: niosII_training_project checkbox.  
Click Finish. 
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7. You have now created two new projects in the Nios II IDE, a C/C++ application project and 
a system library project.  However, the C/C++ application project is blank and we need to 
add source code to it.   

  
To add the file simple.c to the project, first expand the niosII_training_project folder.  
Then go to your PC’s and find simple.c. ( Browse to C:\altera_trn\Nios2\software.)  Now 
drag simple.c into the niosII_training_project folder in the Nios II IDE as shown on the 
next page. 
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8. Now, highlight the niosII_training_project_syslib folder, right-click, and select Properties.  
Then, select System Library from the left hand side of the Properties window.  Ensure that 
the stdout, stderr and stdin devices are set to jtag_uart and that the System clock timer is 
set to sys_clk_timer.  Set the Read-only data and Read/write memory and Program 
Memory to sdram 

 
Please refer to the Figure on the next page. 

 
Note:   
 With this step, you have created a software project that uses the JTAG UART as the stdio 

device.  You have also placed different parts of the compiled program into different 
physical memories in the system.  

 
 

drag 
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Click OK. 
 

9. Compile the program by highlighting the niosII_training_project folder in the C/C++ 
Projects window; then right-click and select Build Project.  (Note: You can experiment with 
running this command in the background when prompted, or just let it run its course in the 
foreground.) 
 

10. After the compiler has finished download the program to the development board by 
highlighting the niosII_training_project folder, then right-click and select Run As-> Nios 
II Hardware. 
 
Note 1:  If Run terminates before the code downloads to your board, and you get a message 

pertaining to the JTAG download cable. then select Run > Run… and from the 
Target Connection tab choose the appropriate download cable that you are using  
and then press Apply and Run. 

 
Note 2:  The Nios II IDE will actually Build the project automatically for you if you just click 

Run As -> Nios II Hardware without you having to explicitly go through the Build 
step. You can enable or disable this option in the Window > Preferences. 

 
This will download the program to the development board.  You should observe that the 
console window in the Nios II IDE displays the printf statement from the simple.c file.  Now, 
press of any of the buttons on the board, and the lit LED should shift to the right. 
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11. Now, let’s run the debugger on this design and step through some code. Start the debugger 
by again highlighting the niosII_training_project software project folder; then right-click 
and select Debug As-> Nios II Hardware.  The debugger will launch, connect to the target 
and download the program ready for debug. 
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12. Set breakpoints on line 22 and line 37. (If the text editor in the Nios II IDE does not display 
the liner number then we need to set those in the Preferences from the Window menu.  
Open the C/C++ folder and select Editor.  Check the Show line numbers box and press 
OK). 
 
To set a breakpoint, simply place the cursor in the grey area to the left of the line number and 
double-click.  A circle should now appear next to the line number indicating that a 
breakpoint is set.  Click on the resume button .   
 

13. Now, select the Variables window and view the contents of the buttons variable.  Notice that 
the buttons have been read as shown in the Variables window. Change this view to 
hexadecimal by right-clicking on the buttons value and selecting Format =>Hexadecimal. 
 

 
 

14. Click resume  again. Since the if expression is false (ie. no buttons are pressed) the 
statements within the curly braces are not executed and we will not break on line 37, instead 
we will break on line 22 again.   
 

15. Hold down switch SW3 on the board and click resume. A new value is stored in the variable 
buttons. 
 

16. Continue to hold down SW3 and click resume again.  The breakpoint on line 37 is now 
caught as a button was pressed, so the if condition is true.  Notice that the lit LED has also 
changed position. 
 

17. Click resume. 
 

18. Double-click on buttons within the variables window. Now change the value to 0xe and 
press OK. Click resume. The if statement is executed as true because we have changed the 
button value using the variables window. 
 
This is useful for emulating external hardware events or other conditions that are difficult to 
replicate! 
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19. Let’s terminate the program.  Look in the  Debug sub-menu menu; then right-click on the 
software project thread that is running, and select Terminate and Remove. 
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Lab 3 
Flash Programmer 
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We will now demonstrate how easy it is to download the FPGA  hardware and software images 
to Flash using the new Flash Programmer tool. 

 
 
1. In the Nios II IDE, switch to the Debug Perspective, right-click on, and Terminate and Remove 

the process from the Debug window.   
 
2. Switch back to the C/C++ Development Perspective, go to the Tools menu, and select Flash 

Programmer.  We will now select the software and hardware that we wish to program to flash. 
 

3. Click New, and in the Main tab, select the niosII_training_project (and ,thus 
niosII_training_project.elf  file).  Then check the Program the FPGA configuration  data in 
hardware region of EPCS controller, and select the sof file for this project. 

 
4. Make sure the check box for Program a file into flash memory is unchecked. 

 
5. In the Target Connection tab, select the download cable that you plan to use. 

 
6. Hit Apply and Program Flash. 

 
7. After programming is complete, press the Power-On Reset or (Reset Configuration) button on 

the development board to transfer the hardware image into the FPGA. (Status messages are 
echoed in the Nios II IDE console.) 

 
8. Observe the program running out of EPCS flash (press of any of the buttons on the board, and 

the lit LED should shift to the right.)  If you wish, press CPU Reset to run it again. 
 

Note 1:  Following we are going to use commands to program flash in NiosII SDK. Please 
open NiosII SDK from program->Altera->NiosII5.1->NiosII SDK 

 

.  
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9. The sof2flash utility takes an FPGA configuration file in .sof format and translates it to an S-
record file, suitable for programming into flash memory. 

 
[SOPC Builder]$ sof2flash --epcs --input=DE2project.sof --output=DE2project_epcs.flash 
 
10. The elf2flash utility takes a software executable file in .elf format, and translates it to an S-record 

file suitable for programming into flash memory. 
 
[SOPC Builder]$ elf2flash --epcs --after=DE2project_epcs.flash  
--input=niosII_training_project.elf --output=myapp.flash 
--boot=C:\altera\kits\nios2_51\components\altera_nios2\boot_loader_epcs.srec  
 
11. The nios2-flash-programmer utility programs a preformatted file into a specified flash memory. 
 
[SOPC Builder]$ nios2-flash-programmer --epcs --base=0x00000800 DE2project_epcs.flash  
 
[SOPC Builder]$ nios2-flash-programmer --epcs --base=0x00000800 Myapp.flash 

 
12. After programming is complete, press the Power-On Reset or (Reset Configuration) button on 

the development board to transfer the hardware image into the FPGA. (Status messages are 
echoed in the Nios II IDE console.) 

 
13. Observe the program running out of EPCS flash (press of any of the buttons on the board, and 

the lit LED should shift to the right.)  If you wish, press CPU Reset to run it again. 
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END OF LAB 3 
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Lab 4 
Adding a User Peripheral 
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In this lab you are going to add a user peripheral to your design and run some software to test it.  
Additionally, if there is time, you will also examine the hardware breakpoint and trace 
capabilities of the Nios II IDE in order to diagnose your software execution. 
 
 
1. Return to Quartus II, and unless it is already open, select SOPC Builder from the Tools 

menu. 
 
2. Uncheck the Use box next to led_green. This is removed because we will now drive the 

LEDs from the PWM peripheral that we are about to create. 
 
3. From the File menu, select New Component and go to the HDL Files tab. 
 
4. Click Add HDL File and browse for “avalon_pwm.v” or “avalon_pwm.vhd” - depending on 

which language you have chosen for your system.  Click Open.  Make sure that the Top 
Level Module window in the Component Wizard points to avalon_pwm. 

 
5. Go to the Signals tab and verify that the ports from the avalon_pwm module have populated 

the Name column.  Then verify that the signal interface types are set to avalon_slave_0. 
 
6. Set the Signal Types as shown in the figure below: 
 

 
 
7. On the Interfaces tab, ensure that the Avalon Slave addressing is set to type Registers (use 

native bus sizing).  This is because avalon_pwm is a registered slave peripheral.  Set the 
Read Wait and Write Wait values 0. 

 
8. Go to the Component Wizard tab, and observe the default settings.  For instance, the 

Component Group is set to “User Logic”.  This means that this is where you will find that 
component in the SOPC Builder when you go to incorporate it into your system. 

 
9. Click Finish and then Yes to the next dialog box. 
 
10. Now, go to the File menu in SOPC Builder and select Refresh Component List 
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11. Locate the avalon_pwm component you have just created in the User Logic folder inside the 
SOPC Builder System Contents pick list.  Add it to your system. 

 
12. Rename the peripheral to my_pwm.  
 
13. Click Next three times to advance to the System Generation tab. 
 
14. Uncheck the Simulation check-box, and Re-Generate the system. 
 
15. Once the system has re-generated go to the schematic editor in Quartus II; select and then 

right-click on the niosII symbol; and choose Update Symbol or Block.   

 (Observe that the ports on the symbol have changed to reflect the changes you made in 
SOPC builder.) 

 

16. Save the updated schematic. File => Save, and compile the new design by clicking  . 
Click OK when compilation has completed successfully. 

 

17. Open the Quartus II Programmer by clicking on .  
 
18. Tick the Program / Configure box, and click Start to download the design to the 

development board. 
 
19. In the Nios II IDE, create a new software project by going to the File menu and selecting 

New->Project.  Select C/C++ Application and press Next. 
 
20. Type niosII_pwm_project as the name of the application to be created. Then browse to your 

lab directory and specify the niosII.ptf file as the SOPC Builder System.  Now select the 
Blank Project template from the Select Project Template panel on the left hand side of the 
window, and click Finish. 
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21. Use Windows Explorer to drag pwm.c and the accompanying header file, 
altera_avalon_pwm.h (i.e. Browse to C:\altera_trn\software.), to the 
niosII_pwm_project folder in the Nios II IDE. 

 

 
 
 
22. On the System Library tab in the niosII_pwm_project_syslib Properties page, 

uncheck  Modelsim only, no hardware support, and click OK. 
 
23. Right-click on niosII_pwm_project, and select Build Project and then Run in 

Background. 
 
24. After build completes right-click and select Run As-> Nios II Hardware. 
 
 
Note: If Run terminates before the code downloads to your board and you get a message that 

you have “more than one JTAG cable available”, etc. then select Run > Run… Then, 
from the Target Connection tab, choose your download cable,  press Apply, and Run. 
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25. The message “Nios II PWM Lab” should now be seen in the Console Window in the 
Nios II IDE.  From within the Console, adjust the LED brightness by responding to the 
question “Please enter an LED intensity between 1 to 4 (0 to exit)”and typing 1, 2, 3 or 4 
followed by a carriage return. 

 
26. If you press 0 on your keyboard, it will terminate the program loop. 
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Lab 5 
RTL Simulation 
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In this lab we will use ModelSim-Altera to simulate running code. 
 
1. SOPC Builder can be used to customize the JTAG UART so that it can generate a data 

stream to send to the host processor during simulation.  Double click the jtag_uart 
peripheral in the SOPC Builder, and when the dialog box opens, click on the Simulation tab. 
Turn on the Create ModelSim alias to open an interactive stimulus/response window, and 
click Finish 

 
 

2. SOPC Builder can also be used to initialize the value on the PIO so that the simulation does 
not encounter and “x” and crash inadvertently.  Double-click on the “button_pio” peripheral 
in your system, and go to the Simulation tab.  Check the box entitled, Hardware PIO 
inputs in testbench, and set the input value to 0x0001, and click Finish. 
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3. click on the Nios II More “cpu” Settings tab. This page is used to establish the reset and 
exception addresses of the CPU.  Select ext_flash for the Reset Address and sdram for the 
Exception Address. Click Next. 

 
 

4. Set up the path to the ModelSim software: 

a. Choose File > SOPC Builder Setup > ModelSim Directory. 

b. Now, browse to the directory where the ModelSim executables are located.  For example, 
for ModelSim-Altera, the directory is <ModelSim installation directory>/win32aloem.  
(For example, C:\Modeltech_ae\MS_6.0\win32aloem.) 

c. Click Select and then OK. 

 
5. Go to the System Generation tab in SOPC Builder, and check the Simulation box if it is not 

already enabled. 
 
6. Re-Generate the system. 

Note: When generation is finished, SOPC Builder will have re-created your system and 
produced all of the necessary files for simulation except for the memory initialization 
files. Now, we will finish setting up the simulation by using the Nios II IDE to 
generate those files. 
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7. The next stage in preparing for simulation is to modify the system library parameters for your 
software project to specify which memory you wish to compile code into and whether you 
want enhance the simulation speed of your system by reducing code overhead.  In the Nios II 
IDE, switch back to the C/C++ Perspective by selecting Window > Open Perspective > 
C/C++ or clicking the  icon.  Then, right click on the system library project, 
niosII_training_project_syslib[niosII], and select Properties.  

 
8. From the Properties page, select System Library. Recall that this page controls which 

communication devices in your design should be used for standard input / output and also 
which memories your code gets assigned to. 

o Select sdram as your Program, Read-only, and Read/write memory, etc. 
o Select jtag_uart as your stdout, stderr and stdin device. 
o Enable the ModelSim only, no hardware support simulation feature. 
o Click OK. 

Note:  Checking the ModelSim only, no hardware support checkbox tells the compiler that 
the current project is being run on a simulator.  The compiler will, in turn, remove 
sections of the startup code to improve simulation speed.  Note that the resulting 
software image will not run on a target board. 

 
9. Re-build the niosII_training_project by highlighting it in the C/C++ Projects panel of the 

Nios II IDE, right clicking, and selecting Build Project. 

Note: Once build completes, the file “sdram.dat” will be created and initialized in the 
atera_trn/nios_Ii_lab/niosII_sim folder.  It will contain the executable image of the simple.c 
file that was compiled by the Nios II IDE and will be used by ModelSim. 

10. We will now use the Nios II IDE to launch ModelSim.  Highlight niosII_training_project in 
the C/C++ Projects panel of the Nios II IDE, and select Run As > Nios II ModelSim. 

 
11. This will open ModelSim. 
 
12. We are now going to compile and run the design in ModelSim with the help of some macros 

that are generated by Altera.  We provide several macros to you which you can execute at the 
ModelSim command line.  They are listed in the following table: 

 
Nios Simulation Macros 

Macro  
s 

Recompiles the Nios II processor and peripheral source code 
and then reloads the design into the ModelSim work library 
for simulation.  This macro resets the entire simulation. 

c 
This is a legacy command that is not supported for designs 

generated using the Nios II IDE.  It’s purpose was to 
recompile source code and reinitialize the system memories.  
For Nios II the recommended approach to reinitializing 
memories is to recompile your design in Nios II IDE and then 
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restart your design in ModelSim after the Nios II IDE 
compilation is complete. 

w 
Loads the wave_presets.do file, which contains predefined 

ModelSim waveform window information.  The 
wave_presets.do file loads the common signals from all of 
the processors and peripherals that reside on-chip and 
displays the ModelSim waveform window. 

l 
Sets up the ModelSim List window with predefined signals for 

viewing simulation results in a list format.  The list format is 
text-based instead of graphical. 

<UART 
name>_drive Optional.  For each UART in the system, this macro is created if 

you turned on the interactive/stimulus response window 
inside the SOPC Builder before system generation.  When 
you run this macro it opens a window, similar to a terminal 
screen, where you can send virtual data to the UART RXD 
signal during simulation. 

h 
Help.  Displays the available macros and their functions. 

 
 
13. Execute the s macro to load the design by typing s in the ModelSim console window.  This 

will compile all of the design HDL into ModelSim. 
 
14. Execute the jtag_uart_drive macro to launch the interactive terminal window which will 

display the output of the printf statement in the simple.c source code. 
15. Execute the w macro to display the ModelSim waveform window with example signals that 

were automatically generated for your system.  These signals are separated by function and 
include signals useful for debugging. 

 
16. Now, let’s add a few more signals to the Wave window:  From  the design hierarchy browser 

in the Workspace window, open the test_bench folder followed by the DUT folder and 
select the_led_green. 

 
17. In the Signals window, select chipselect and out_port, and drag the highlighted signals into 

the waveform window, and place them at the bottom of the list of signals. 
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18. Run the simulation for 300 us by typing run 1000 us at the ModelSim console prompt. 
 
19. After the simulation has completed, the terminal window should display the printf statement 

from the simple.c file.  You can also zoom in on the PIO signals that you added to the 
waveform window with the magnifying glass tool in ModelSim. Observe the CPU making 
write access to the PIO. 
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END OF LAB 5 
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Lab 6 
 

Accessing Peripherals and Timers



Exercises Designing With Nios II & SOPC Builder 

  Copyright © 2005 Altera Corporation 
 A-MNL-NIOSII-EX-05updtd 

43 
  

Part A: Use HAL Macros to Access the Button PIO Peripheral 
 
In this section, your goal is to create a program that responds to user inputs from the buttons on 
the development board.  We will continue with the example from last time but change the code so 
that you set the position of the LED’s using the SW0 to SW3 keys on the board instead of typing 
commands in the console window.  
 
You will use the file, “Lab2a.c”, that is provided in the software directory as a starting point for 
this exercise and fill in the missing sections using commands that you learned in the previous 
section of the presentation. 
 
 

Step 1 – Create the Software Project For this Exercise 

1. From the File menu in the Nios II IDE, create a new C/C++ Application based upon a blank project 
template and same .ptf file as before.  Call the project Lab2a_NIISW. 

2. After this completes, add the file “Lab2a.c” to the project using the same method from Lab 1.  This 
file is partially completed for you and is shown on the next few pages. 

 
 

Step 2 – Complete the Code 

1. Modify the code in all seven places as indicated by the arrows to get it to sample the button PIO 
inputs.  The operations should proceed as follows: 

 SWO = position 1 
 SW1  = position 2 
 SW2  = position 3 
 SW3  = position 4 

To accomplish this, your program needs to capture the contents of the data register of the 
button_pio peripheral and then write the appropriate position value to the data register of the 
led_green peripheral.  Utilize your class notes and the partially completed code fragments , and the 
appropriate hardware peripheral device driver files to guide you. 

2. In order to check your syntax, simply “Build” the project in the Nios II IDE. 
 
 

Step 3 –Run the Code on the Board 

1. Once the code is complete and successfully built, download and run it on the board. 

2. Highlight the application project, Lab2a_NIISW, and select Run As > Nios II Hardware.  

3. Test all four buttons on the board (SW0 to SW3) to confirm that the LED’s change position properly. 

4. Once you have established that the program works, terminate it by pressing the red Stop  button 
above the Console window. 
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     Lab2a.c 
 
#include <stdio.h> 
#include <unistd.h> 
#include "system.h" 
#include "altera_avalon_pio_regs.h" 
 
#define NONE_PRESSED 0xF  // Value read from button PIO when no buttons pressed 
#define DEBOUNCE 30000  // Time in microseconds to wait for switch debounce 
 
int main() 
{  
  alt_u8 buttons; 
  alt_u8 button_val = 0xf; 
 
  int  print_cnt;  // Print Counter (prevents infinite printf loop) 
   
  printf("Hello from Nios II!\n"); 
  printf("This is the Lab2_Part1.c routine for the Nios II Software 
Development class\n\n"); 
   
   
  // Initialize the registers in the LED_GREEN peripheral: 
  IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x00); 
 
 
  printf("Please enter LED pattern by pressing SW0 to SW3 on dev kit:\n");   
 
   
  while (1) 
  { 
      // Change following code to perform fns described in comments below: 
      print_cnt = 0; 
       
 
      // 1.  Sample SW Button from Dev Board:  *** 
      // ??? 
       
 
 
      // Run De-Bouncing Algorithm: 
      if (buttons != NONE_PRESSED)  {       // if button pressed 
        usleep (DEBOUNCE); 
        while (buttons != NONE_PRESSED)  {  // wait for button release 
          button_val = buttons;   // strobe state of SW switch 
 
 
      // 2.  Sample "buttons" again to update with new value  *** 
      // ??? 
   
        } 
      /*  usleep (DEBOUNCE);  */ 
        print_cnt = 1; 
      } 
      
 
 
      switch (button_val) 
      { 
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      // 3.  Change four instances of IOWR macro fns in case statement 
   //     below to write to the data register in the led_green peripheral. 
   //     (ie.  change "// ???" comments below) 
 
 //     Note:  Data Register Values for different LED Positions: 
 //     -----  Position 1 = 0x03 
 //            Position 2 = 0x0C 
 //            Position 3 = 0x30 
 //            Position 4 = 0xC0 
         
        case 14: 
          // ??? 
          if (print_cnt == 1) 
            printf("LED Pattern 1\n"); 
        break; 
         
        case 13: 
          // ??? 
          if (print_cnt == 1) 
            printf("LED Pattern 2\n"); 
        break; 
         
        case 11: 
          // ??? 
          if (print_cnt == 1) 
            printf("LED Pattern 3\n"); 
        break; 
         
        case 7: 
          // ??? 
          if (print_cnt == 1) 
            printf("LED Pattern 4\n"); 
        break; 
     
    }     
  } 
   
  return 0; 
   
}
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Part B: Use HAL API Functions to Utilize the System Timer 
    (Optional) 
 
In this section, your objective is to determine how long a “Test Loop” takes to run in the file 
called, “Lab2b.c”. The point of this exercise is to, once again, call upon the API functions you 
learned in the last section of the class to perform the necessary operations. 
 
 

Step 1 – Create the Software Project 

1. From the File menu in the Nios II IDE, create a new C/C++ Application based upon a blank project 
template and the same .ptf file as before.  Call the project Lab2b_NIISW. 
 

2. After this has completed, add the file “Lab2b.c” to the project.  The code for the C file is shown on 
the following pages. 

 
 

Step 2 – Build and Run the Given Code on the Development Board 
1. Select the System Library Properties page for the system library project, and from the drop-down 

menu for Timestamp timer, select high_res_timer.  Ensure the  sys_clk_timer is still set as the 
system timer. (You will need both timers for this lab.) 

2. Build the project and run it on the development board. 

3. Observe the fluctuation  sequence of the LEDs’ on the board.  The LED positions should be looping 
from lowest to highest position. 

 
 

Step 3 – Modify the Code to Implement a Timer 

1. Implement a timer around the “Test Loop” in the code to determine how long it takes to run through 
the test pattern.  For optimum accuracy, you will also want to determine the time required to handle 
the call to the timer routine, itself – that is, the timer overhead – and subtract that quantity out. 

2. All these code segments are started for you.  Use the API commands described in the last section of 
the presentation as a guide, to allow you to complete each.  Also, complete the section that prints the 
result to the console window. 

3. There should be a total of five modifications that need to be done. 

4. Once you get this program working, jot down the time spent in loop: 

 

 ____________________________ (ms) 

 
5. Terminate this program by pressing the red Stop  button above the Console window and then 

pressing CPU Reset on the development board. 
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     Lab2b.c 
 
#include <stdio.h> 
#include "system.h" 
#include "altera_avalon_pio_regs.h" 
 
#include <time.h> 
#include <unistd.h> 
#include <sys/alt_timestamp.h> 
 
 
int main() 
{  
 
  int i; 
 
  alt_u32 num_ticks = 0; 
  alt_u32 time1, time2, timer_overhead; 
  
  printf("Hello from Nios II!\n"); 
    
  // Initialize the registers in the LED_GREEN peripheral: 
  IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x00); 
   
 
  while (1) 
  { 
   
   // Check Timer:    
      if (alt_timestamp_start() < 0) { 
         printf("Timer init failed \n"); 
         exit(0); 
      } 
 
 
   // 1.  Determine the timer overhead involved to record time stamp:  *** 
   //   (Uncomment the following and edit...) 
   /* 
      time1 =  ??? 
      time2 =  ??? 
      timer_overhead = time2 - time1; 
   */ 
 
 
   // 2.  Sample time1:  *** 
   //   (Uncomment the following and edit...) 
   /* 
      time1 =  ??? 
   */ 
 
 
   // Test Loop: 
      for (i=1; i<5; i++) { 
       
  switch (i) 
  { 
   case 4: 
    IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0xC0); 
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    printf("LED Pattern 4\n"); 
    usleep(500000); 
    break; 
  
   case 3: 
    IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x30); 
    printf("LED Pattern 3\n"); 
    usleep(500000); 
    break; 
  
   case 2: 
    IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x0C); 
    printf("LED Pattern 2\n"); 
    usleep(500000); 
    break; 
  
   case 1: 
    IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x03); 
    printf("LED Pattern 1\n"); 
    usleep(500000); 
    break; 
  
   case 0: 
     return 0; 
    break; 
  
   default: 
     printf("Looping:\n"); 
    break; 
    } 
 
      }    // end for loop 
 
 
     // 3.  Sample Time 2:  *** 
     //     (Uncomment the following and edit...) 
     /* 
        time2 =  ??? 
        num_ticks = time2 - time1 - timer_overhead; 
     */ 
 
 
     // 4.  Print out the time it took to perform this loop:  
     //   (Uncomment the following...) 
     /* 
        printf("CPU time(ms): %.*f\n", 2, 
((float)num_ticks/(float)alt_timestamp_freq()) \ 
               * (float)1000);  
     */ 
 
 
  }    // end while loop 
  
  
 
 
  return 0; 
} 
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END OF LAB 6 
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Lab 7 
 

Build Options and Interrupts
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Part A: Create an Interrupt-Driven Program 
 
In this section, your objective is  to take the program concept from Part 1 of Lab 2, but this time 
instead of using a polling loop in the code, make the program interrupt-driven.  That is, 
construct the code so that the user sets the LED position using the buttons on the development 
board, but this time the SW0 to SW3 buttons should interrupt the processor.  Implement an 
interrupt service routine to deal with the request.   
 
Use the file, “Lab3.c”,  provided in the software directory, as the starting point for this exercise. 
Fill in the missing sections using commands that you learned in the previous sections of the 
presentation or by referring to the interrupt section of the “Nios II Software Developers 
Handbook.”  (Start -> All Programs -> Altera -> Nios II 5.1 -> Documentation) 
 
 

Step 1 – Create the Software Project 

1. From the File menu in the Nios II IDE, create a new C/C++ Application based upon a blank project 
template and the same .ptf file as before.  Call the project Lab3_NIISW. 

2. After this completes, add the file “Lab3.c” to the project.  The partially completed C file is shown on 
the next pages. 

 
 

Step 2 – Complete the Code 

1. Modify the code to make it interrupt-driven as described in the synopsis above.  (SW0  => position 1;  
SW1 => position 2, etc.)  Create the ISR based on the notes in class and the partially completed code 
provided. 

2. In order to check your syntax, recall that you just have to Build the project. 

3. You can utilize the Software Developers Handbook for an example of how to implement an ISR.  
You can copy the code ALMOST VERBATIM from the C Examples section in Chapter 6.  The 
Handbook is included with the Nios II installation and is located in the documents directory. 

 
 

Step 3 –Run the Code 

1. Once the code is complete and successfully built, run it on the board again. 

2. Highlight the application project, Lab3_NIISW and select Run As > Nios II Hardware.  

3. Press all four buttons on the board, ie. SW0 to SW3, in sequential fashion, and observe if the LED 
pattern is changing properly. 
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Lab3.c 
 

 
#include <stdio.h> 
#include <unistd.h> 
#include "system.h" 
#include "altera_avalon_pio_regs.h" 
#include <sys/alt_irq.h> 
 
#define DEBOUNCE_DELAY 200000 
 
 
 
/***************************************************************************** 
*    ISR Function Definition:           * 
*               * 
*****************************************************************************/ 
//  3.  Complete ISR definition after completing steps 1 and 2 in main loop below: 
 
static void button_isr(            ???              ) 
{ 
 
// 4.  Cast "context" to correct type 
/      Should be declared as type volatile 
//     NOTE:  Buttons are *not* debounced *inside* the ISR!!! 
//            They are debounced in main program. 
 
    ???   ???   button_val_ptr = (??? ???) context; 
 
 
   // Debounce the Buttons: 
   usleep(DEBOUNCE_DELAY); 
 
 
// 5. Set the value of the "context" pointer to the value contained in EDGE_CAP. 
   *button_val_ptr =              ???     ; 
 
 
// 6. Then reset that register to 0 
// ??? 
 
   IOWR_ALTERA_AVALON_PIO_IRQ_MASK(BUTTON_PIO_BASE, 0xf); 
} 
 
 
 
 
/***************************************************************************** 
*    Main Program:                 * 
*               * 
*****************************************************************************/ 
int main() 
{  
   
 
  // 1.  Declare a button variable using the Class example as a reference: 
  //         ???           ; 
   
  /* Initialize the button's value to 0 */ 
   



Exercises Designing With Nios II & SOPC Builder 

  Copyright © 2005 Altera Corporation 
 A-MNL-NIOSII-EX-05updtd 

53 
  

  button_val = 0; 
    
  printf("Hello from Nios II!\n"); 
  printf("This is Lab3.c for the Nios II Software Development class\n\n"); 
   
   
  // Initialize the registers in the LED_GREEN peripheral: 
  IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x00); 
   
 
  // Initialize the button pio. (SW0-SW3) */ 
  // Enable all 4 button interrupts. 
  IOWR_ALTERA_AVALON_PIO_IRQ_MASK(BUTTON_PIO_BASE, 0xf); 
  // Reset the edge capture register. 
  IOWR_ALTERA_AVALON_PIO_EDGE_CAP(BUTTON_PIO_BASE, 0x0); 
 
 
  // 2.  Register the interrupt handler.  
  alt_irq_register( BUTTON_PIO_IRQ, (void*) &button_val, button_isr); 
  //          ???           ; 
 
 
  //  Print the message to STDOUT...  
  printf("Please LED pattern using SW0 to SW3 on dev kit:\n");   
 
   
  while (1) 
  { 
      if (button_val != 0) 
      { 
        switch (button_val) 
        { 
         
          case 0x1: 
            IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x03); 
            printf("LED pattern 1\n"); 
            button_val = 0; 
            break; 
         
          case 0x2: 
            IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x0C); 
            printf("LED pattern 2\n"); 
            button_val = 0; 
            break; 
         
          case 0x4: 
            IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0x30); 
            printf("LED pattern 3\n"); 
            button_val = 0; 
            break; 
         
          case 0x8: 
            IOWR_ALTERA_AVALON_PIO_DATA(LED_GREEN_BASE,0xC0); 
            printf("LED pattern 4\n"); 
            button_val = 0; 
            break; 
        } 
      } 
  } 
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  return 0; 
   
} 
 
 
 
 
 

 
END OF LAB 7 

 


